3D FTEFFI A

T RS RS
Al T W EWR



BT BD FTEIHEIR ..ovveeceeeeeee s 5
113D ATEP AR T A e 5
1.2 BDATEFHEAR D E oo 5
1.33D FTEP AR IZ oottt 8

1.3.1 JERRITAR PRI R IZ oo 8
1.3.2 HEBPEBHABELRIZ o, 9
133 REARERIZ e 10
1.3.4 5 B SEARFEEE A FEEHE AR s 11
1.5 BD ATEFHE AR oo 12
(IR DI R A Y 12
1.7 EAIE 3D ATEPHARILIK oo 15
1.8 3DATEFMH B EREBEDE (e, 16
1.8.1 B BHAFE oo 17

EF SDFTENE B e 22
2.1 B K RVEAEE B BDATEF L e, 22
2.2 HIERBIAR LD oo 23
2.3 HAE/Z BD ATEF 20 e, 24
24 BRI RKITEI L e 25
25 — 2B KA FWRETE e, 27
26 2/ 3D ATEFAIRE oo 35

BB BD I I TR, oo 39



31 BT HAETEI (o 39

3.2 BT MAETAFNE o 40
3.3 BALBRM AL oo 41
34 ABS ZM oo 43
3.5 IARAULLHE oo 44
3.6 FAEFREG LM oo 44
FIE 3D FTENSEBIHAEFRE oo, 54
4.1 X EA 3D 3T EF AR B AT oot 54
4.1.1 "FA A KB A 3D ATEF i, 54
4.1.2 HABEABR RIS 3D ATER o 55

4.1.3 FEZBRAFEFIE 3D ATEM oo 56

A4.2 HABAFREATZLIR covoveeeeeeeeeeeeeeeee e, 57
A2.0 FAIBA oo 58

£.2.2 FEPEFFAEF oo 60
B.2.3 AT ET oo 62

R A | OO 66
EHE D ITENTHIAEEBIR: oo 69
5.1 FE 3D 3TEFHH oo 69
FEREE SDFTEMEYIIARL oo 77
2 B - o SR 80
6.2 ERTALIEE BI AL oo 82

R A2 s o = = SRR 84



6.5 @A G ED 3D ITEFMAL (o 87

FEE FBI D FTENFR oo 92
7.1 28 3D 3TEP AT A oo 92
T TR 7 A S 93
LT o 2 2 T 94

7.2 AHARE 3D ATEFILAL T ] o 96

EA 2% s S 2 S 97

7.2.2 FEHATIL I T oo 98

7.2.3 B AT Bl oo e e, 99



F—& 3D ITEIMER

1.13D TP H A B A

3d AT Ep ARG M 3% (additive manufacturing, AM) , & —#F 14
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ZEE Ak, BETE AT S MERB AR, FLOEHR, 24, 4
CHEMAH T IAR I 3D AT R A . LA T EA B thmeH,
R G E AR SR VT A8 K ILF & 69 R A4F, & A 3D ATFF T KA
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B, BAEAER RSB o AT TITEIE A K625+,
HWBMGRESMMF R SH T, Bt B ATHE AR %49 3D I7FP A4
¥R PLA, ABS F#BHZHHT. #20F%k, IDATHHRKKEALK
e, BE AT FRRARG, BRRAE BT S REAMEFH
HFE VAR, BHBRTHAMII L., £ET4 Lk AR BT

B, e 1-5 i, AT B8 SHa stk A, EAE AR
A%k 3D ATEPH R GG B 35%, RIS FARE K 20.2%,
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B 1-53D 47FF 2 &AR IR AR I
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JE X RS G B A AR AL, TRIG S A B = 25 TALAR B R F I EZ R
3D AT R HIAEEAT B #AZR A ) & 69 £ T o0 i is S AR A
P, BRI T AR B ARG AR AR RAZ I FARAEF R, T AR AT
B ERTIETT RN GIEM, SH Won 5% F 3D ATHHKE#T
E#FR, I XT E8F R Lotif, FARBE X K442, S Bose
SR A 3D ATEPRR, AR T BB =BT T @G AR .
Sb, 3D ATEP LT VAR T AT 80T AN F AR, P& R LEHme
fRAT, ARASEQRMEE S, ML LR, BATAFEET AR
RoAKRCEF T EMTEROM DT RGN, BREIHT 3D 4T
o, THEHMESEEAOM KRR, PANGRAZTAOMEHN, AKX
B R By M NS AR T HT 8918 12,

FEAZAKRANER, 3D ITHFHARTERA —FF XK, TR
KRG TR LT FR e E, Bar, SDITHRARACEH T 57,
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P SFUATIR, 3D AT & ST AR AL A L8 AT R . £
ElALZ ALK BB & Ao M R 3B - R 69 #7 7 3D 476 “4 5 T2,
RAZHEK, TUE—-RZAZERHAREGZR, BRTE
232 M, X —E e ARBKRIRE T EAKE, BFTHT 3D
TP A A A OLIE AT IR G F Ao 3B 4T 438 7% 80 0 . IRAY 2 4%
BRI K H R E A X AE 3D ATHF, KRR E BT KA it RAFa9IR
XA, AR EAR AT E Ko

%2, 3D AT 5 & B ARRA S A AR, EAERY ME
BRI ENL, EANKRKRFNAEN “FE4)iE” 17T BEHE
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1.7 B A5t 3D TP E R FLK

HAr, B 3DATHRRCARFE TS ZEH, 2% EMTAM
K. AFEHRE, By, TSk, MRS A S kA, B
FEE R F S0 ResiE 7 d & A = 69 )

B 1986 < Hull X9 % —& 3D 4T¥PALAk, EShXT 3D 47¥P
BRI H T KBAF T KR K. 2000 F%E Zcorp 85 H A
Rilcen Institute Bx-&-#7F 4] i 4 & 47 P AL, 2010 4 % E Organoxo - 8] Bk
A KA I Invetech 2 8] &1, X CAE AR 0 AR Ay JR A FHAT Ep AR 2827
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EXAET AK®IE, ATER., ER. EBURAREAAER, AR
YAAESFEEE, SDITIHALRZE TGP RIFNGER, Rk
X B AR E R GR G e AABRG Y K. ARIE 2020 F 3 A Kid
FR 5] K A G (2019 SF 4 3 A P H 3D TP 4T k4 4E) , 2019 5, &
3K 3D 4TFF e ALAR X 11956 12 £ T, HKEH 29.9%, FHLIEKHE
e 4.5%

£ B A 2K 3D TP T HR KT . 2019 F £ B = LA & A
HILE 40.4%, REMKTE£E, YELZES =,

154 3D ATAPR TR M e+ B, HLILF, WK a L el#FaF &,
BARFEIGE KL — £36, 2 b—F T RAHEHmiLfet b L
o BK, BREXGTHHEMR, LR TRV ENIDTHITLE
Ky B Rk F, #£—FEHT PE D T SRR E
1.8 3D ATHMHAZRES X

3D 47FF CGEM#H1iE) A RAER A E AT E, L 7wl L
BT AR 6 A . AKEAPE L3R, 3D TP XA R AF)E,
TAMFAT R, BPAFHaY Rk < A& 3D ATEPRe A £ 2092 o 3D TP
JRMAH B R AT R, R & T L 09E R B KT e E 2l
RRELBRERAE 3 ThhabR, mikdazisash, —RELH K
SRR BN E, AMRERIFOASN. BAT2ES Z2AHEM AR TY
FIE R0, #IDC (International Data Corporation) M, #zR&
AHIEMHE A 2016-2020 S 1A FRAFGY 22.3%F LK FETH, &

HRIBAFH]E FFAE T 2 4 2025 S 2 HIG AL 7~ b 9T A8 4332 2000-5000 12
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BA7, 3D 4TEPAH L2062 Ak, MM REeitifa& Aty
B AOMHE . Tafst &R TR, BARIEH G La——if MmN 4,

1.8.1 &&MH

YEA 2 /% 3D TS EH R —, 3D ATE Rl & &4 & Bl it B &
BRI E | R R AR E B F R0 T B Ao
TEMFER, BAT2B D ATIR RS & T AL RO LE X,
KFEFaF BT K L, LFERE RS IR S .
BATERFHE, RATHHREE LRI L. 55T R EFH &0
MRS (95 %A L) | RaZik, 12 &M T bk
&, EZZELHEBEEEFZHERESEITHHH &

BATH A AITOMHA L R4 ELE, KAKLL 2. £

AL 2R 3D TS M THLET. BIRANN—£E4,
STHEMAMT, BRETRFET. MBIREFHE, T2ZREATEL
ITLFEREREET, BFE LG IDATHASLELLSEH AN, I
M. HRRFRE BRF . S R AR AR, AD. AT,
Bl BT B A BRI Ay HuLR A T, 45 A)E & TA L Hlie, 3D 4TFP A K
HMEARKESEN—KREA, FALZFHKEEUMRT, @ 3D
ATEP 7T AR 4004208 09 1 B 5 A 6y UM B R A — 2, RRiRFTE
B3 Ok, A RERT esklEHREGELF 4, 28 Dresden X



55k ok 3D 47 FP A4 H 4 FeCrMoVC 7 B, A L A R B
B LB, ST, EAFERE KK .
ke b W AH RATO FIRMAL . B0 LR E ARG RIBIK 7 K F
A, BT RE B TR A E TARBRE AR £ ) 2608 A=,
SeMHT LIRS, BATE AT SLM AA &7 LIKE A
Al-Cu-Mg. Al-Mg-Sc-(Zr). Al-Zn-Mg. AI-Si % . 3 & Nottingham X
£ 69 Aboulkhair 5 AGB AL R 3R, 2 H6E B AR R RS e T
I LA, BHADFEL00 WG T, e ANKF T 2% K ik 99.8%
&9 AISi1OMg 4787 #F. Kruth 5 A8 4767 4h K TiB, 4% AlSil0Mg
ha b e 8 HMH, #1& T MARK TIBJAISIIOMg 84 #4, Hisih
B 3% BT An g iR fe A2 M TOT5ALHR £ .
KA R EAIKE B s 5% A A T80 B At Bt Fe it B R AR
FIEFiLAe 5 A LA RIATa9AA S, s 2 fl TREMR. BT &
M L TAEF) BAMFIT I, FWEERFH R ERIAEZIL AR

1 3D AT¥ k& F M B BAARANR, £ E&F E KIVB R G o4k
KB BRI EEE, MR T LRI T I B IIIRE B AR
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VISR, ARFRATE /% 3D T2 FE R KA A K. Ren FA
VASREY R JRAE, —AF 6L 46 B H AKE BIR O M A2 5 8 ( PW- LDPE-SA)
HABE AALLEFIIR R, 1F R RN | 5 A B A s 5 Tk b 4R 414t
QPR AR T L. XA T H A 3D AT PRI 4T, MRS
2N £ & BT R0 15 2 AR

HEAHCRAMRSEA R EFRRMEAE, EMTE. AEFM
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Nl T ARR O AR ZoH K. mHAH 5 RERBEGAL,
I B RAK R R mI e Rt R, RESBEEFIET L,
X RS AN JE BT B IR AN G 09 )5 /32 77 ik Ae ) & ROR THl e
RAAAMFRR S BRI H 0952, RAF R T HL—H
e 094 Bl & K,

LR BA LT FHRR, wAR T A& SR AR,
AR BBR K, LREZAREE, TREASEE LG, ¥
PR Ry, T AR TR, T B AFA R A BaY )2 K iE,
Tontowi ¥ /52t RAAK R #AT T RA 5, LR EAARAA B AT 3D
TP HAR LA H) & B e BB b, BAFZRAER &
Mo A4 3D 4TFF, TRFMAE R R H &, HEREZE. g
s A AP AR Y F K.

FI, THRIGEZLEM, AR R4 E, £ 3D TR RS
A EFAUBRE KA R, B, —&BA A EER AR
BATEAMATARRAT 3D TP, wBRABR L5 LA £ 00K

PEAY B ST MA (RUHEE, RUMHALARBILR) £46.
1.8.3 LA H

18 ¥ AT FE A 4G B R AR A Mo 2 1 R T e i 1R R 28 4 AR 89
— R AN BH. 52 Z s TAHFARL, € RMUEA K
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F. AMAR N F T E A , HELYT AR MR 7] B A,



TR DREMA. T FE, EMKR. EWETT FARAE
ZRR. BEBMAERS T HEIDATEFPHER. WNE, RAY
TR EMHT AT 3D 4787, W= A48, ZILRIAE, BERR =
5%, Liu Fi8id PVA BIE ALO; KBk g i e, #14& &
PVA-T8 ¥-3R &M A5 B 64 K, @i SLS B o M R AT IR
AR ERT, BERAS S THIRAMES PVA HLE¥E,
% B HRL K32 A R A% F 3D 4T FF 77 & 438 ) 69 A8 5% [ A HH X
TTPH B0 TAR, LA AT 1700CH =i, KREAAZAMT
LR A BAEATIR K B F Fo AARARINA, IAAR, 75 R494E
A PR T & AR AMAR F3R ChL L6 KA R4 e £
% (e BMERE) NEY 35 S 4. % B Soligen
Technology 2 &) A A k645414 3DP H K, ATePME R £EH K, #F
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E_5F 3D TENE B H

3D TP HAR —AFH A AT R A, ER B R 8 AT L F A
e T RAEATAL L, #LA B3 T AL B S A8 P A AT R A R
e, Mm R RMLEEE = o) AT H B, ed & FAale KA = oA,
3D 1T & Bty AAE A &8 B4 3D AT T 24y Rt H, HH &7k
HANNKE , 3BDATH BN RAERN & &R 3D 4T = it E &
A —3R, LALMEPTE

BAT, &% 3D ATFHFHEA IR EFWICLRE R (SLS) |
T RIEER RS (EBM) | @5 HHOEBICRT (SLM) Feigokik
HA A5 (LENS) o Hvb st 35 M SO AR A 5 e # b, HhAk
R @t BobR, TABERSE A K, B2 3D ATFAR A&
S A—MEIE: TEM. HRAMN, TNHER, LR KESE. 45
meE. BHLeF,
2.1 B ARBEEEELEIDITHHIL

BE2BIDITHITARKRE, LALFABTIEREEAEE
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TANSMARE, BIEIKT 2MWIRAE, JFILERT 3D ATz
ey £, KRBT RATH 7 @) 5] A2 69 B 250 3 42 AP AR 69 # vk
3.5 REM 4

RRM AP M EA R P IR RS oM R S pRE R
REGMA, R TAMTAMKR, 38T HEREIFEEATLFMR. BRX
A HAL R e TRtk A AL, — A E AR TAEMTA
FDM £4f, 2 R RAREF, ATerH s RME R 204 F i,
TP =L 350°C, *F FDM X &89 e ki B & Kk &,

T Martens, L Mears % 75 K 4% F] J& R A # R 47 7 7 45 2 AR R AF
PR A 09 AR AT IRT IR IE . R BM A AIRR T A%, 4T
WA TAE IR B e TAE R ) T KOG, FFAB T R R | dT
FREEIR 89 77 ko 45 R R ML Al FDM 47TFR ROR AR LM AE R B S5 AL
& TTAIT8,

Huang B, Masood S H, Nikzad M #F X T =AMNE & T2 5% (G
WA B, AAE B AATER 7)) 3t FDM 476 REAM #6955 7
FHR R, EZANTREEZME (1Hz, 50Hz = 100Hz) TFit
HANE ) F o, AFRE & T EAFT ROR AT Ep 4 [ R Ak 69 %7
vy, F5K M Taguchi 7 ik R MRAL T & A F AR 3] P AF A9 TR RE .

3.6 RAXBK B 244t



BRTRAG A —FFHRE, HiEW0 TARH, BELA BTN ES
PERE AR HUARDPERE , )2 M Bl T IR E AL (A F Tk Ao T 2% Tk,
REBRBE LM TR B, LFWAF, TS B LA RRG IS &
PeAk o 2R B o TR A A, ATER R Saad B 0 R, S LR K
HAME TR, REFHE ABS HREMEN S 27w EHERNDY
A 5o

Masood #F 52 7 FDM L Z 54k (Le3h 8 K, M % Z A= XM A

) SRR BEATIP XA AP AL ) # v, R KL EEA

ju)

100%, SEAHHSEE A4 0.6064mm, LA A 45, T HRMA RS 9 4lp
5% %, HBT IR AR BR B AT B X AR 49 £ A 5% ik BV B R A4 70%~80%.

K. Cantrell 3 B K 3 5 B 4% 48 X B AR B T 04X 3D 4797 R BR
B AR 69 fa b Ao 5 b MK, A0 T M A B At iE 7y ) 3 R ek BR B AT
PR A T A = A B b B IR GR LAY RS R
3.9 RAE LA

RS T8 G KEAE R A RARe) A48, L BA RAFOG N FH
At WHEME . RUBMRMERE, A —APEST 3D ATH M. BT RAEE
— Ak ah R A, T AR ARK, KEHER, SRALMITHE
WEHEE, MTARELBETHR LA TN E L,

Masood. S. H 57 & 7 —#7 L T FDM I & #1545 L a9 37 A 4/ 2
T B A, 3B A9 AR B AR B A 4 & s A Fe Bt 18] o 3 3T SR 30 A
KT %5 BN B MR 6 R R, 5 e A2 B P 4% 8%

KA B RSN B SMARAITT IR, BREALKIRLEZHA



3: 7 B, TR ARERMER, XL EMBLM TR AT
il g FDM 4T6PALs, T A#ERR W TEE AL, XEH B
E B B0 )38 p) A Fe BT

Tuan Noraihan Azila Tuan Rahim 3 7 & 7 —#t Z &K 2 &k & F= &,
WG 32 R 12 89 5 A e ht, BAREBER B4 F H) Swtd, A4S
A 15Wit%E, A A&LMAH REN FHE, £ 57 @ L4 Taulman
618 o 2 AP R AT b AT i, B &M 8958 4 5 Taulman 618 48 %,
W T A9 Ae Ak H A% F & T Taulman 618.

Boparai. K. S % il i R AL 23R4T H5 h Lhy T 2 A4 (Fm 3R AT 3% |
MR, KR, ERAERKR TG EFLT PAGIAIAI203 £

SuMe MR AR RE, TTRIZRLLHAEA ABS LATH9H5
Ko RTFTHRFEAF L RLHERKXE TEEGTAZ, FitHEHS
2B R KA iR B e AR R £ e RAES M JHR T R B
IET RAESK, EREALSAMERIRZH%.

Dickson A N %9 A Fl i 4L a8 41 2 . 55 W 4F U An IR 41 2 R 35 3%
B Z A, #1& & FDM 24, #FRL TR, HfE LR folt
I G AT R AR ) PR AR R SRR, AR R AR AT YEIE 5%
B RBLH ) FRER K, LR g s REg iR AW 6.3 12,
3.10 A A KM R HH B A

Jo b PEREAR AR, A, Hsn g RTAL MARKT, At T ER %
BTG R, TR ZARE T X # )R, EHfHFE A F, £AE

VETRE AREE AF FEAMEMRFABAET L



R B REMFETH — R b, fEA—MERES S THA, £
Bl s RAILLEF K, BKFELE S, SRR LM ITIAE EHERA
FE, MR AR BOR M R F R, B AT E A Iy —
BB AR B S RARBA R AR E AT, RS A F
PERE AR ML RE R R T80 SR 8938 2 R0 A RALAE 2 B 3A 4,
&by R Fo g HURI PSR

RD T REMEEEAR T R R RT, BFHRALR
G4 — 77 @ 7T A KGR TEARM B A, 55 — 77 @E AR B M A R 4R &
ST EEMHNERERFB Ty A

-
A RARAY KR S, R 09 BB 2, SERP, =& RE,

P& Bk IR P A

PERE, TARATT R = tEat

WIBMER, B Eh . REE, B E, BAL, ZAMKF, HAAZ
& E RBAE, Ak, b, BT, BAARSREMNFRFE
HWRAR S FHae, RATEEFEHRAET, i TMKR, €T TE
B4 o 2 A 892 A AR AAH e & Su ok RARM, BHE 5RE4F)
B R, e TVAR ARV T @A RAT AR R 2 F S, i T BRI
5 R &k R AR B B A9 WARSE IR A R BP TT A K % BOA 5 H0
9, BAAAKEBERIFEFTELSH L SR FDM R LM, ERL
e NE Y AGAFE, AT AR F LRy B T A, 25 FDM 47
PP R A R A R HAF B, RN TRESITHH 092, AT HR
JE S AR AR, IF T KR B IR AR

S RL A FEARR G AR FHREH ., £242R T Fe
MBI F SRS, EXHERESM T AR MEN AT



RPN BZMEER, RAEm T E2HMT, HARRAN FAREAFTRS R
Sdhho THRE, IR, K ERF K2 F 0 A 2R & LA A
B FRE . AR ERAN, BHERSM TRk, 51287
TP FRASHANERERATSE; 22K, REWFEMAZ
oA, BHRERRFRILESMHA FHAETE. FDM 4787
IR THABAGER IR E A LT, ERFHRIT N ELSF SR
#3F FDM 2244 69478 T 2 AT ER il S AL 09 %50l , A il 53249
EF. EFHEHFREFIEIART K, AT @ EFDM 47
FIAUREEAE KRS N 0.4mm, HEHHRTIEKR, 2EATHHEEFH
IR BRI AR, SORHOAA I R SR R TR S
T @A A F AT R WA IAA, R R IBMER, BB, A%
A5 A o
3.10.1 ¥k

WIHMEL (Glass bead, GB) A& —#f H 2 R M K & &9 HLIBHAK,
FEMBRS AR R, MRS RS, ARSI Te
HWGHEFRT 28 R FIBMAKEIHRIR, EAMRIFGRINNE, 3T
He TAX & 69 A Fe B FEAAR )N s ISR R ), AR o B ST,
R, T SR R AR RR Y H Sl g, A3 ] e R T AR
R WA A AR R AT, AT 1300C A L3 iE . R AR
£, TRH RSV fodt SRR LR CBE R, T
RATHARBERESMARR S LT AR,



AR EHIBR MR G RAG T &L, F R ARABER | 20 3 385K
o BIARIKAFBEAILIT AR 5, &8 3 69 M —ABEX T /2 AL
Yhe R EMZ AR, AmAZFREAE . B 3-1 P A AL A% B
15 R T AAAA R @ o BOR A

B 3-1 AL ABEEHE A AAUAA R &= &R
TEREAFRLT 2 S HFIBMHIT A 6 89 ) 5 P A bsAokE K5

PR AR, HERE Y SR A AL T 20Wt%r, R 6
B9 Fi A 5% B Aot F AR B A B SRASZHREG M A, Mg
A BIBMER I N T T Fhm) R 30 2SI MAA A H R
REFTHR, NEFHMREE ., ol kB EE @it 44ty
BT AT, L REHIAMASZ A 10 W%, ZAEMH#
FPEREHRA B KRS, FIBMAA AR T A AT AR AR T AT
Long. S xS IR MR IG 5% R KB B S AR89 B F AT A AT T AF
K, EREVLSMIGEEZHEAEIOER A AN T EmaD, 4
BLA ¥ G R Fa BN 5 0k 69 BBk T VA S 42 5 5 A M4y

B ERE

AR
3

3102 ML



B+ (Montmorillonite, MMT) £&—#F 2: 1A E kA& K4sat
BRI LR T A, T By A AN EF AL, HALFE XA (Al
Mg,)SisO19(OH),*nH,0. K 3-2 RER LG ZEHTER. T EA S
A, IR, BKMARE HAFH R, FREMSTZATHAR
S, B RAER S P HERE MMT, AEMEERE, B&HM
EEMAARE R AZK, BibE 23t 50 ot 47 st A 32 RIG 5%

5 R HZ A a8 8k

B 3-2 F AL

F L B SRR KR, H A LA b 89 o hE ) AR 85 AR A

A A BT A RE ) AR 2, B T et P B L SR B2 AT
BB, A MM FINER L EN, AL ELFMAR, TIUE
FRLE TSI, BAFORMR, BT SR B @ A e i

ACERIAIE, o5 R AW KD T H ST A& L LA HH

bl



RERAMEMET FEEAMBTEREEENNBZE., 5T E2@EER
A, EBTR@ERER AR, RS ERAME ABARIR B F .

i A AL U s R B A2 POE-g-MAH/POE # #¥ 20 P 7
DA At 3G RGN R A 11 B AAMAHR R B S M R GX A
#HATT RAMFT R, B 05T F BT A A A0 4 5 A A3
AL T Fm a9 K F= 0 #7. T D Fornes % &2 T B A B = Hu 6 5h
AER LT R 6 AR B AMHAH EFfeth it a9 vh, AT ZB L5
REARKL 6 MHESCREAGTESHET, MLT
Wyoming, Yamagata 1K 2 &M AH69-F A K E S K, FEHEK
TREHBAEERS, BAZSOBEYBIL. RN, AL
ARG A, R B AR E AR R 5.
3.10.3 &4 4

s ¢t 4 (carbon fiber, CF) Z &L E & E A 90%A LAY .E 2R
LEah AR A — A B AL 4, R —APiE B AL S AR F & HARATB A
Je & T AT T K AT R AR A ARAT R BR MAES TR A ER AR
SRR RAF. AT iR, WM RRMRARST — R K B Rk A YeAR
PR E DA EG RS, Kaptffndastitt, m FDM 4TF0 LR A% —
A 0.4mm, FAHAERKE LKA ARER, BmWmKR&T L.
B AT Yy B B BB AT L RE AT il e AT L T T | AR AR RS K
ARG RAARE, AR LhERK AR I Ll 4%,
HTERRELLEBRE R, SREM BRI IR IA P 5K EH

g, BRI B



B R BPBATE, LEELAAFFEFERALBEREL, 5R
RSN E, RikS5REWEMRTY RA A, KT
w0 A% R, BT AT R B A R RS R AT R A S SRR R b
BF B ST pRAAET EEERNF ALK, RRF AL, F
BT, REE WFBERERRAET,

Junxiang Wang #= Mingyuan Gu #F % 7 4k 4F 4 38 3% 2. £, 1010 2 &
MR A TR AG T O BRI B, 5T Eh4, Kby B
BWRAREAR B TRAENIGR, EEMHNMENERS T ANKE
B, AHHESEAFHTHEERAR DT TRESFTO. £2—F R
A 1010 4T ) Bthe AR 69 K AESF b b F R AR R R FREAL
KPR ERENELHZ,

Wang Z, Huang X %75 7 PAN X% 4F 4 49 w4 52 A AL Fe L3

KeFE T2 P AE L R A AT A B IR ARG 2 SRR 0O R vh . R R U,

WA 5 EAAE B A Y0 A bR BB S T 16.0%, W a9 B R ALt
A% g R v, B A LR G IREBAEIIALS A TRATERE

T AR A YR IR P e R E ARG, B AL TR SR IE A T A A 2 e IR AR
R Tk g, H— ey LA R\ W sk E AN 73.6MPa 42
% £ 81.0MPa.
3.10.4 44y

%248 (Aluminum powder) #% F3& 7T 54 Tk 4ahy . A .
RAsb Hehss, Iz RTiae, LI, 2406, BB, 2R,

REG, K, WTELH FFHFiTk, St m A TREM Y —MAF



N —Fr B AT RN, R HLFRT A A R AIR, BB ER
RN A ZARE. BiahBERELS AL, kR BRXERS
M G AR FRNE, s ar AT K S E 2 L7,

BRI TP E R T R AR A . R @A RO AR R
AT, O F AR F . AR E IR A A AR R A 2 La kR
&, 5 AR AR ARIR ) A Ak B BE AR IR T o AELEAB IR F| BOLE S8k 89 LI
idA24e B 3-3 B s, kB BEAB IR 69 VE I ALIEAL | 2T 8 KBS
A, —FP RACF AT, ARERBE AR IR P A AL Bsah A @ 4 4,
A WE ST E, T HERBEFAERAIE LM, F—F2EHT K
F A Z AR OGBS, AN A R BR BR AR BR ] A2 MR IRAE ) 2
Tz A, PPAkBRBSABIAA P Ay Ti 424549 sp’d® 2ol mda
AR IR & F A dn &~ A B LA A

Fl A F5 RAURRASSe 5 RA S K AR R k&4 4w
Pl TR iR kR R R 12 B sk, TR T A A Ak
BT R FHR AR ARG R, A B3 s AU A ABS A
e B GMBRATT — AR, 2T RALL., BB ag. 4oMiEs
BRI 2. et BE L oM # ) FHRAAENR R, Gabriel
Pinto FF@ i3 423t L R 6 A4 KRR e H & Ak fE, FFRT

B Ao TR, FE. REAMAK.



SEVUE 3D FTENEEM AE#1£Y

KBRS T AR Y T, RAGEXAF AT RERR R A

FR R TN H ST, AFBLH ST RH5TFT LAH0E LA PT3
ARG FE R (IR A =R FAF RS ) Fedl 2 69 4 32 MR
(Jo R R EFe 5w )R AL IR AT O 5 T A AT

ABAIRE, BARCESEBERAHBR, KUV HEER), E£2HE
SRR, L Phh Kk CEINR) 51 A5, HARA LK
Fo £— & K9 I K (250 nm~ 300nm) BH FEAE 225K S
B2, Tk B S, AR — RIS, THTHRESRE.
AR BARME, RETE, KB A TS AT LE
PEEA AR, TR, BRER, A7 8Fg, EXRAKEE
FERE, EFRAE T RR A, B AT, HBE AE R R A
& FARREP R Tk 5 Ty @R AR R, mEEBA. KK,
WA, wF. mE. BERNFTRAE) 2.
4.1 X B 3D TP B AR & At

B 3D ATEPBP AR 3D 4TFP . TAFAZAL R FE R 8 i AR X
RO AT E ATE I 3D BT AR, R FARR R 5 R S A AL,
MANATPAL A, ATEPAUIRIB 2 IR 2 & B AT B 44 . 4 i I 49 B 9]
IRF R4, KE 3D 4TE B AT 22 H =4,
4.1.1 "R AA X B4 3D 47¢7

"RAT R L B L 3D AT P A =AY B\ A ARSI R T — A, mAT A
B4 3D 4TEP 8945 & R HANE 5 RIS R A S E A —NER T, A



Mg A LA T gt, AR B, BARE AR T RS IR R A
BEY, BEITRCR R OL M IR A B AR R 6 RS Ld, BObR
AR CRRAT B FPIE WIEF), R AT 6 R BAE AT BIAL, B
PFREAMELE, FEGHERBAFRENES TR AL, KRE
"Rk B PRAL P b L B A AT B, B RSEAR A B R E
P, SRS XTATEP AR 2E4T R B AL IR RR VT o S A 77 i ) T A AR 2 S R i
S R AR 5 TRk, i S AR S, AEIES], Ao BRSO
fa A5 ol s 30 TAS AR AF H OO AT B LR A B 4-1 P,

Jetting Head ——————, " X axis
4 r s Y axis

\\\1‘
UV Light

Fullcure M ———

Fullcure S —/
{Support Material)

Build Tray ——/ e Zaxis

B 4-1 “F AR5 & B 4L 3D 4T EF AL AR R 32
4.1.2 Bt BB A HS 3D 4T¥7
B B AR s S 3D 4TFF (SLA) & JUF i R #ha9 — 4
Elf 3D 4767, HAEB A, EAABRKT W42 LE L 3D 47F7,
ZAY XL 3D AT ABMMAE HRA B A 7w, BAE A LT 43
1, REMIEAET MG, Bf— &, MIEEG-FE TE—E,



de b BB o AR A T B AMRBERR @R, HOEELFN
2%, R AT A A K KIBAT P LA BE AR, SRR E SN AR
HTATEN, REMIEEARAEET ZHTH—E5E, BF5K
ABATOPRANT — 5, B EATHENLEZ THO TR, REHKRE
T Ao bR A A9 BB RG B ST 3R AF T & 69 T4 ARxd T E— X age5
SR LB 3D 4TEF, mATATER 7 Xk & T ARG 694, Bifm T 4
FILR, YT ABEE R 5 TS, T AR AR B AL B
FRGER. EIEREWA 4-2 FTT

YA

st. 128588 g

B 4-2 B BBk st 3D AT FF TAE R K
4.1.3 HLRAKSF-@Fi& 3D 477
% AR g £ B AT T AR F A A R K kA —A
MILL, M AELERAET@HE (CLIP) , & 2015 3 A XA+
Bt 3D 4TFP KA £ T (Science) 4k &93 @, X AL E 4L 3D
TR AANRE LmmAy, BP: 4760, T, HATH..., ©ABTAH

PEAE T A — MRV RE, ZRFRE2EE R R EINEATZ



I ey | itk ey dl v\, EMGAEGGRIAE — NEHROE D, LG 2
STAE RSN R S A, BT AR A AR AR R R — B BG4
e, B A BE X, XL TAEITIF 2121860 E LR M
Lk B B EAERIR, et BB TR o XA kR T L@ A
AB AT MR R AT T A B GFAE, HETHFIRF, &
B KRS, A E L megFE, Flamthit LAk F, 4838
ATAY SLA # K, #4RAF®4]iE (CLIP) fedrerayR BRI T I

A8 20-100 15 . [ 4-3 A i G iR AR & ] 1€ TAER 2

Continuous Liquid Interface Production

Bulld = - UV Curable
Plattorm - / Resin

Oxygen T e - Dead Zone
Permeable et -
Window

Projector

B 4-3 E LR R d i TAE R
4.2 AP RE G B AR,
B 3D ATEP M AL BR A LB IR . LB, &2 RSO
AT ARG, FIRMIERHRE, BARIKEESY, & £ B #H
RS, AHME ZEE MRS FRABER . LI RF AR E R

3 3k ] 22 A% o



421 MR
MRS (LARRIKRY) A —FBAEAAE, &H a4 gt

/

RS TR e, FRW T RonA A T A AT LB R 2 69 7&
HEAR, TRAT G Vg R AL RS, —235ARE, T2
TR S, Rk B A BARK, E—ASREAA R, TR —
AR ER KA, 7T & B EABT P4 60%-90%, B @ E—
MNABEAEE T ¥, FRIARNEMGGAS, ke T LB
A LM AR AR R B AL H] e 09 K R3S AR, e IR AL . F o AT
B BRI S A B AP K FE S, HL A LM R F,
F R G R AT E R,
AR R BB G B AL AUIE BT AJe R LA R 2 B e B A6k
HALE Fo B B F R A RBAM G . B AR PIRRY & £ F R H
Bo 2 RAT 7@, #bE (I B9 IR 4 2 B3 A0 g 09 258
B, BL—EZE, AMBETAZGFOAGREALRZ L) , 1%
tRe, KRB E, S0, RS, LELRE KRB IBRL

ff?x/m /% 4- l )ﬂ uv .ﬁCT Kﬁhéﬁ:’*"?ﬂ{“j’riﬁgo
% 4-1 % A UV BILT B LA tE e

RKE BEE BE Rt miTHE R KRR
AR ES 18 I gD 53 ER s A4t =]
P BR A AR tr & ¥ AGF 4y (3

REGUH R AT e AR ¥ Akt el

REF RS AT & i3 AoF i3 fi&

H AR R = A s TEANH [
REAMEHA MG #® =i 33 LSS A "




st F R 63| KR EARFR, Pk A FRApLH R TR 69, &
A A ARIE LT AL 6 R R MR TR, R EH LR &S AR A, A
AT RE R R E KT R AMBE R A>T A AHBL A ST ASHR
A B, 8B ALBMIEKRR T RGIKRESD T BHE LR BRI,
Yo R B A M ERA G . TR 2 BE A M BR AN AR . 3R A TR M B AN RS AL R A A
f&% . M&HF A KARFR BT A RFG TR, Prt Qe FRBER
ARG, MBTRZGTRDEAFALR., RCHAEBRAR, )
o IR AARG . T M B RS

TR R AEXRBMIET BT EZGRS, 2T B =% iF

% T 0% T mag At B E LB AR B T P 69 55 R 4 64 i ik
FREERZAEZ. TEATH@:

O#s B s BT AR R R BAG GRS M, 7T e T8 — A
T RAGAT, &G OHE BT AR & B R E A RGO AT AL . L RS
BRI TR A, ET R Y E AR 6 R, B E e B
P8 5T ATE 4K

@K E ik B & TAE RN 3D drEpALAT R, MOk AR R 4
BF IR AT R K AR R, LR R R B R R TR 4, i 3D
TG E &,

@I /) F A FHRWAEA AN TR 0 & RBAAE 694
B, A TR ABCE B AL HI a9 R . FAntE. 2R R, iR A
ABVES ) R, —ARRRE LS. TP AR R, LR

BV R, R Rarakersk, R ST



@D# su by BN LG & 3t T 3D 4797, #I4Fa9 B L 2 —/
ToEROMRIETR, FEMOKEFRS, WairipdLdHass
T, BB aFaTAK, La@rasl ey, — L A% 4
FRA, BAHERE EARK, BEALH e fils B AR Z G Ao,

OF ARl & T AEK 3D TP AR NEAL, AT,
ARG L RE R KT R F, 3T AR B AR

422 EWMHER

EHARER XMARR FHER, REATUARERSGH I,
T, HEMF A FHRGREERA, AR B B
SAHMEE LB AL R A LB EAE, B, EEFHEER A
G 69 71 SRR LA R v B AR Bl S 69 M AR o MR ) A R K
PRG R £ 20— ANARI G, EIRTUR A 694E L, 1545 B IR A
FE 3D ATEPHLEAE Bl o BTVA, PR ] 09 e 45 Fa i Ao b A9) 6 0 g
MAELAE T T &,

MEEM EA, iBiE B w5 R A B SRR LA e ek Ak, 1) e
CHadk, PRAAMBLAL, RELASF, Bmadlie)Eniikiet
— S M B B K 69 K dfE B TR BLLAK R BT R 69 M AR AR A
A FRERRE O AR BROY AR, B T O M A B R 0Y F M AR 0 ok
MR R ARARI AN RLTARMBFRLIAFI LK)
[F $L ST A ) ) A B AR B8 & AR

ARABEHE/NEREIRY T THITR ARG S V347

XN, THALErARHRE., WEREARHRIE, 5 kHAA



BREESF. FERREERRT, 00T HBLRAE —A R EART
S H R, 5FE8 0, #EIK, #HER)%. Ritd TEER
BRABERRETRE, AFLEFTEERAEELIKHEL, LK
Ko Z ARG FHEEEIRE THENS T FARSHAADSRANALGT
B8 Re W), ARG WG A0, K ER E G 0%, 45 HAR R MEA),
ARAK . & HEEEARET LB 09380, IRAKE LA, I T 1%
W, AL E LMD IEm, Kam#rad S ik, FE RSP T L
B K B RO 6 & AR H AR S AN B R AR £ 8GR B AR
AR, FA E AR AR A3E e, —T5 & 7T 38w ok B R 89
W, 7ML T B BRI AR R 6 IR E Ko do R R A
A E PR, MR AR R R ERAMR S, RibB R ERIK, R
AL ERERGERES2 B, BARRT KA IR, 1353
IR S BIAUAR 3 69 STIRAZ E 69 Sy AR T BIAL &= 4064 77 52 M Ak A fl

AR KZrh. & 4-2 K JUAP & A7) 3 8 B AUAR G A8 69 %5
4 o
F 4-2 JUAP T W69 & AR R A R B AL RS T RS 69 %5 vR
— AER-f - MFE_FRM_- ZH=/-F JNEHRE HERE
7.8 A ZHAmRE  BE (D YK h g
R 20 9 15 25 9
(25°C, Pa-s)
E4bE] (s) 20 40 30 20 50
A 22yl a0l T P E 5, i

EEFEEFRTERFEATHZE:
O P ARAE B TAK, WARRE ) R3%, VAIE RS T An T0E fE



@Y T 3D AT AT, EFHEARSEIZEAKER., K%K, KIF
K ARARHE

@F ARG RARILLE F, AR LR a9y 5 T,

@EFZW R, KRR ERE, 2RERERLAAERS
B, TWEEEZ AAELERAIRE, #h) FHAE,

O =i ftts, FHFAAEAHER, & F A% BIT 0 B MAS B
= AR A AR | R F o

4.2.3 K51 AF

* 5] & F] (Photoinitator, Pl) 284X T VL= & F M P AR, K
T ME R A G R A5 AR, ST RE, RREAI RG] R AT
BEAG &9 BALR FE R, A RAFEEANLBRR P RE T
3%, W HAEXRETAET, LI KR EE KR RA R A,
HCR KA MR R (250 nm~420 nm) &9 5] K R AR A 5 98K 5] R F
RAIAFOE A EARfem B TA, i TREGRZMNIE, §iia
AENAFT oA R BRAS ARG AE AR AR, BT EE46L
EABNANA: KSFHRIAF. Ko THIl LM, ahk-rasF
MR AT AB KA ] KR SRR AF

1) &AL 5] K5

M & T AR R 5] AL G420 ; Kb Rag R4t fa s T4
KA R AR AR RE TR, S H T ERT e, FR
Yo Fo i AR AL N LA AT R AR . 483 T B b ARk 5]
AF, METRLINKKRZAUTRE: ARG 0], {23 T



KA BmEFY LB, B5HFHME; 85T RBHAE KRS
B IRAKE, BALEARAOILGE ) 5 45 21424 s 18 & T L BLR AR,
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RN, HALRGSCORBCEHA, B R B RREE R =AY, BNE R H A B 3T
SFREER . BRI . SRAGERELFRIEEY B, BEEE DR A A A

WA 3R B () EERF S AR AR R HEAT 4k K LED KT BRIZE B WA K T 44k DAk
AINEECE, BN SR BRI AL 0. 1 mm FROTERR; 4T Bk 580 22 8] S P 2 i
0.3 mm IERR . WIS IR 16 B, HAMZEWE 17 s,

K16 fafbgii



B 17 LED Z5# 2% &

3+ AT RAG
SR JE R KT B 1038 HI 3 6 N SEBR ARG LR 8 2 S A A i

D BAMERIIRN 15 W, BICHEN 20%, Frel A7 I 1. 2W,

A~ source [ total heat EX N 1.2 W,
2) ZSTENREELT, HimiREASHIE 100°C, HMAHEE KRS

3) fESEhrEME RS, T RERRAINA TR, BT ARSI

FEAR 6 AN opening, FHEREIIRIRE AN 25 C.
S G ok B AR RET, B S AR IR 3 B .
3 MESHRAEER (B Wnek)

MEL W W Rt SRR BOA R R ER

SHEH 5 340 10 5 230 | 1

HIPEES:

» HUEX

e RZAT B o3 W AT RS TSR 15 BURARIR B /AT 45 R W 18 B

Kl 18  LED %I #4ARR FE 3 0 A

K 18 RUIT R rnim AR ARG b, HirmiR s 76.23 °C, BRE—EMIRE,
WA vl fe et e K Fo 456 80 °C, AIAL, % LED 4T H. H A BRI Il B 2, A7 6 3256t H
AT R GEREAT S . Tz AT BRI R R R R R R H i, 5



SMEIERZ, AT SRS, REARIRIFRIE S,

NI Griaany

GBI R T B X EE A s G, He v B Tl ek, IHKESE <A
SOREBUR E, T R BN BVEFERE . B HR . GURMEREIR | T EOREIA |
OB BASOR . KU B AR T BB AT et (B B BB IE
R AR SR AT 12 A AN ], SRR R R RS T Ui $E, SR Mt oL 1 S A ekt
AR RE RSN, JFBerh 7oAl 3 b7 5 AERER R EINSedis . e U . R A A 2
PRI RAR AT I o

XFBL IR T R B A RMATR e S A fa, R T RIAT R

(1) ZRBRARZ AT %

CCHEBETE %I SY LED BRI . RS BRIV Y S R Rl D, TR
JE RE R HRRLT, R AT AT, AR T AR BOBOGBRGT . XTI LED AT, Rkt it
TPz he B, TS BCR T BRI, XA TR EIRUR A S IR R, A AT vk
Fo

Bk IR R A8 AR R D T R BAR R AT JR VAR - IR S O — S IR —
HIADT— P AR — G — 38, TR A I 19 B,

LD K \\ \ // AKX

P iR

A

B 19 Btk LED AT #m 2%
FEALgh K 20 28 24 Fros. B 20 A%EAS LED RGHEE S AAE, B 21 21 24 4
SR LED O s AT S IR K B R 0 AT

—-_— = Cmm—
4. 74102 4%, 159) 47,8774 4R, 008K §0. 4134
45.450) 16,8684 48,2065 49,7045 51,1826

K20 2R RS I LED AT BERR 37 73A



o ﬂ:l:l B:;:D Dn::l‘l

sS0.2482 50,6843 $1.1328

Se— ——
45.7733 46.6301 47,487 48.3430 49.2007
46.2017 47.0585 47.9184 48,7722 49,6291 T e T T T TIN T
K23 FAEERGIREE I o)A Bl 24 HUA R ) A

BT LED SRR, 5SR-S T % E R
FE A S, AHARER iR A E S, LA )2 B B R % i i S A
IRIREZ %,

AT B4 B b T LRSS SR 51, 1226°C, FHELECAR SRR EBC TR Z, B
FESCVIVE I A, Ul W et 5 A S L 2 T RCGAEDSR,  IER T SOk Jo B S i I T AT
(S

(2) B TT %

FIRT, RTh# LED YT A i 2 RGOSR B, HIEA 2 M BRI BRI R
ST X FHEAR TS, TR I T T RSE ARl de e i Re i JLA EER &
T A E A RS HEAT LA

B FERSHERERAEE A WA EE B, WA EEH LB RRERE ¢, WnE
24 ime AHIH A=2 mm, B=6 mm, H=40 mm, C=4 mm.

=1
[ I_l'

==}

B A

K24 #i GEAEDY RS
1z H ANSYS S35k & 1 D RE SR A Z R IE AT AU A #:AT RSAk, tRAimAz
1) B4 H=40, C=4If, 2»HELA NN 1.5, 2, 2.5, 3, BN 4.5, 5, 5.5, 6, XfA.
B HHATALA ISR 16 418, (B HEEE] 16 FEAL N SHE, KR — AME F45E5 B
R R M s 4, i 25 frx.



A L A A
4.5 5 5.5 6 6.5 7
MR WNIEs/mm

Kl 25 AN[ASE A JE R S5 bl Ta) PR A AR OG R
mE 25 nTLAEH, XTE—A AE, 4 %MEERURRES,  #RRE ) E
PRIG R SR PEACE THE,  SAMNEHGERT IR, 25 A=2, B=6 I 4R &AL,
2) 24 A=2, B=6, H=40 (1KMW, BLC N3, 4, 5, 6, 7, 8, 9, BF CHELEERNK*
7R, w2, WA 26 fos. ATLVE M, BEESUEER TG, GhiRdetisfEIK, e
B PE R R AT R, HAE C o6 i, HUS -SSR i/ IME

1R5 T T T ]2
78" R
78F
TSP
- 2 76
5 7t 1 E
g o 74
T 76, "
S| 3 o 72
[ 1 70t
755¢ 1 68
"_‘. e A A A A
- 1 i i i v
L 7 % 9 % 40 s 6 0 s %
A A B Crmm W 15 2 P e
Kl 26 B RS SIRCR Kl 27 @hSESERKKR

3) M A=2, B=6, C=6 BIfEH T, 2 HIEHAE N 30, 40, 50, 60, 70, 80, 90, fH%|H
BHEE&RMENRR, WE 15 P, vLVEH, BEEBFSERIER, S5 7%6 KIEFK
BE 5 AR RAZ, AT W& AT s T S IR BEARAE AR R, 4024 H=60 B 3 A s
FEE R 25 U ) B A A

M4 A=2, B=6. C=6. H=60 WJHLH Y HRGEE N,  BRS5EN 70.97 C, Bk
W2 BT RLIBEIE T 5.35 C, BIOL, XFHEEH A AT AL SRR I & o

(3) InZEME TR

PER—FME R RO, AN ORERE,  NEERRSAABRE, @I AP
IR A4, K LED KHMAE S HIFEO . AETE LED BN AR Z MR, vk
LED 05 E 35 AR IVE AR I IO, el i T Pl R, (Rl A 1 2
REM G VBB BUE . RO BEARINIE, (ESCBRN A, RiE.

T T B IR PR R, IS AVE S S5 28 B, AR FOR 2 mo
PR A 28 R O R AT, UL TRy, A E SR A, A0



FrREnEE 1 ARAE . BB HRE R HAIGEE 30 000 W/ (me k), AINHATTFA 450 W/
(mek)o

K28 I 5 4t

PiAARER, MERE RS EREICT 2.24 °C, ATH, INEEHEGR T 250 %
%, £ LLJE BB 0 AR ol mT DAS il e A S 2 e o B B RO RAS B A IO AR

(4) FHmt R %

FABH R BRI AL S RE SR 2R, T HARIEIE F IR 2E SRR L,
AN KW o HINEAEYIR A EE LA T (05 AR, BB ABE ROy SRR 34
S PSR [ R S BTN, pR SRR AR IR s Ak B AR T B G R
TR AR R SRR R R R PR AR A IAFEL A, (R I LS T AT REAR B 1) S R A
o ERCT BE SRR RS X AR, AR TN R R R AR 8] 1) ST A
BT TC, 3 T USR] 3 R B AR R I O A, LR 4 o

R4 AFFEAET B R

Ll UEZR R R By Uy I8 1 i P
/(W/(m-k) e Ic
2 101.93 69.66
5 49.87 68.26
8 76.23 67.47
10 74.54 66.05

FHER 4 ZdEnT k1, FUHADRL S HCERIMEE R, 50K S RIEREAC, B A m A e S
T LED U A RS KIGPER, R TE 2 BN e v v H AR g FH B8 4 () SR A R I,
NI FEEAR S THT A AR I — 5 L300 ) 52

(5) IR TT %

R i T RGA SRR, AT DU KRR R AR s O BOARER . I KU T N E
TR 3 B T 2SN intake BRI IRVE , S0 BT 45 SRR IN2E R E L EN 0. 01
kg/s WRJG, A BREEERERIKT 9.76 C; % 0.02 keg/s KEJE, KT 16.01°C, Af
JLJRE T LED AR B B AR

MR EHE AT DLUE Y, R 5 R 5 1 [R] A BE R 12 B R AR B SR o (EL e X
FAIEAELE A B 8. O AT A XU 25 A LED 75 A UUHC (4 o) 8, — XU A e 2 9 LT
/B, T LED 5 rIKIE 5 T3 /N s @nze KUs 2847 B RAGRE . W AR 2ot g vk -
R, K X IR I HIE AR LED AT HL b, AN — R IR (3 3%



(6) TR Beit /s

PR AR A BB S AVE AL, (B AVE AR G — 4R, T RAIRARGE R Y R A
Jre BPURAR AT MBI B, SN B . 1205 RO R FE TR AR R R i
PTEAR TR, BIRAREBACR LR R, 45N 71.09 °C, &1 5.15 C, 5i4h,
HC e 7 ) BRI AR 5], AT L AR R — R

XA N EE ORI LED ST REAT 1 Aot SecdtBevt, IR ANSYS B3 2
BERT S5 LED AT BREATIREE (T F o, AN R R G et . 4R R, B
LED AT B AOHAPERE AT LRI I 4 A7 30 OXZRBRARIZ A B, @0 XU SR 55
HIXHAAE s @RI B EBOR; @& AR T &,

CUHERGED

HREORZ LED BT R i o BaR 2 —,  RAF IR ITAT B RE R AR
iE, RA7R 1R LED fT HINE A R AR AT, HASOR T Btk 4 2 EA k.
W FARBAREH I A SAL IR, MM E AR S I S I ik B
FIERIA R IF B DS B ECR I B, Bt LED KT I /AT, TR I TR A A
A, AECABLE DT 5 AR LED MR BT Dt Bt SRA BT B EARH), FEES
L&

[B%5%X]
Lo BOIT R AME G0 HORIRTAMEAT SR TR AR 2 SRR

77 253 ) E R R T SR ?
2. MR BSOS A GEE 2 A?
3. M RGuE T IE FR AR (T gk 2
4. UNfIFE ANSYS HEEE PRI J 70 A7 ?
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1. H4E Tracepro Yo F it At
2. HEiEFH Tracepro AT H WHBE S A SR
3. 2ot AR TR B R R S A AR BT
[Hise EHr]
1. AEPNGRAE H Tracepro Yo Wit 444,
2. BRI %

(£S5 AETHAE 2]

MR e A Ul e ALk 07 1 (], R SEBDEIEE RS2,
AR EOR R . MEHDELR @R, ARPDEEBE, —REERADERI LD
PRI AT RSON RAMERYIEDE R ED . XIS, BAFES T
PERIST O X6 A T0 S IR B H AN FOR UL 5 ZEAE B IR I e B, A ik
5 EFI R B B2 Tracepro, BT KM IIRE, &R T JLFHra IR R 4t
IRLEE

f£%— Tracepro i/

Tracepro s —E&0 USRI RFE 0T, RGO, RS DL 70 B A,
BHRE —EHAG TAFRHER ACTS SEARBIAY 2 IR AF By K R SRR . et 1
fE o oy B4 1, B DARATTRE S 52 ) A AR Y, ST AR &, DA SCBE M RRR I,
FETH P A GYRR I ] DARI I JE 224 58K 58 B
1.1 Tracepro FIEMERENH

LR Tracepro YA fE, FEFF 2 HaN0IE 2 G 5 P EETT 20, ngesehi. fi i SChiz.
AR R HE RS RRIESE  Horh CHS oM SChin, nlidid TR Rk AT 1B 0.
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H 3| _I_I_I_l_l_l‘_I:I_Ir_IJ
2/9/8| &R Q&4 4| 1|t/ w - \z*l‘«l“\ || [ Bl=Elm]] TR

X

EB&K

SRR

S
Kl 1 Tracepro [#AE S
M 1 A4, Tracepro ¥AFME R, IS RFAEES: FIE0 ., PR R,
RGM FHTX . AR X IR TAEX . ABPRIR SR B B X .
TN TR — T i R PR T A A2

Y Y x
x| zd4| z34

Y x
Lz | vz

qlala|ale||)EFlE ¢ I -
HEBEH TR SRR SERTA

plael:|p| Ble|=D] OBB|m|

BWARTMATR EWOPHRTA
AR
HHEH SRR xz&:y;%
B
e ,\ =
bloo| ] 1] ¥ ik i —
= i Peeinin
. Rg RE., BEIH —— KIEE S

R #1%: View>Preference, MALRILAEE Tracepro #AEFH BN HIKS
B, SRR, 4B AR, BoRotekmEit, J7 %,



.- Preferences E”Elrg|

Ray Colors ] Bay Display ]

General l Zoom ] ¥iew Dptions ]
Linear
Secale

Defwult [es [Celsins @) > |

Apply

View>Customize, BEALTIULE Tracepro #AEF I H BT HHIKIZE, WFALX FI47
B, EMPERTA, EEEET, HSrEnegs,

(R =N (= = e v =l e earch Corporation' [ raceProt T raceP o, mdk Browse...
[rata Directory: | Browse...
Auto load scheme: | Browse...
Flace System Tree an |Ieﬂ zide of Model Window j
On starting TracePro |open emply Model Window j
On opening models Graphic dizplay driver ~ Enable Spacebal
* Dizplay all ohjects * windows GDI
" Dizplay vizsible ohjects ™ OpenGL
Background Colars Object/Surface Colors
f el Window: I:' Drefault calor: _
System Tree: I:I Highlight calar: _
Evaluator dialog controls: I:l
oK. | Cancel |

1. 2 Tracepro HE#l B

Tracepro BEHUP IR 3 BAHE. @IBIAL, SLsrriE. Stlie. ot ige.

1. BT

ST B 77V LU = Fe

1) Tracepro H M

FIH Tracepro A4S & B DI RE G SRR AY I, ~F 1. il BRTi AEBRTfA . BRAA
BT, HEARFIIAGE

2) FEL 3D Wi A AR, SRJE S Tracepro

£ PRO/E UG CAD 5% SOLIWORKS %% 3D & MV AB ARG T 50 Aok s ik i, fR1F A igs,
sat, stp &M, FA Tracepro JFiZEEIEGE, Bl AT HH.

3) JEEE A AR

Tracepro S1RZ WML ZEMAX, OSLO, Code V 2 ILRIfY, FrLAAT DL EL 3
Tracepro $T X EEEAFORAE [ SCAY

H J6 4 Tracepro ¥ A H @A TT .



Tracepro HAFARGIRAE T — AN SR KAERIE, (HH#7T DARHE B O iR FEAFR
PR AR, HERAEEZ  Insert>

Qefine Analysis

Lens Element... fHABGITE
Fresnel Lens... fEAIEERIBS
Reflector. .. AR
Tube. .. BALE
Baffle Vane... $HABEKXH

Primitive Solid fEAEAER

Source. .. fBAXIR

EHIEPHENESE, Insert> Lens Element, IS 1) BEMEHERE: 2) &S
WHE; 3) EHRMNVERE.

fi. Nodel: [Untitledl]

M Insert Lens Element

Lens | apertors | Qbstruction| Bosition | Ampheric

Units [Radivs  v| hickness: [3

Material
’:(xlag SCHITT = Weme: [BET vi

Surface 1 Surface 2
I Cylindrie [~ Cylindric
Badius: [50 Radins

,_
Cemic: [0
Insert Lens Moy Lens |

For Halp, press X:3. 1683 Y:0.0000 Z:-4 8587 nillimeters  X:1.8483 1:0.0000 Z:16.2835 millinete |

5=

M Insert Fresnel Lens

Ring 0.1
Lines/unit; [10.000000

Materisl
’V‘mag [scuoTT =]

Wavelength: [0.5461  um
Foci
’7 Object [500

T
—
T

X
1
z

Nl

Insert fresnel lens element K:0.5236 T:-1.1487 Z:1.6725 millineters  X:-0. G527 ¥:1.8080 Z:-2,6607 millimeters




o A] DA IX BB 4 /e 5 2%, Insert> Reflector

fi. TracePro Expert

File Edit View EXPVIM Define snslysiz Reports Tools Macres Hindew Halp

Lens Element. J & Wi é Ol Eml| @] |:| ||| 2N
»| B[A[E[ [P Bu]T] ]%

esnel Lens.

Tube..
Baffle Vane

Frimitive Solid
Tart..

Sgurce

Rectangular Concentrator |  Facetted Rim Ray
Conic ] 3D Compound |  Trough (Cylinder)

Shape: [Parabolic | Caleulat [Disneter ~|

Thi chmess: |1 Length: |15
Wole 0 Misneter [e5-832815
Focal length: |3
LS

Origin Eotation

= xp
rp vpo
o 3

in Degrees
Insert

Inzert s reflector

X:=3.4700 08, 8857 Z:-12. 1957 millimeters X.-5. 0453 Y.7.7033 Z.-1Z 8385 millimeters

Hk, Bk 3D Wit @4, SRJ5 SN Tracepro J7vk. B 3D AL S A 775
1) File>Open

EHIEE D | hEriE | ¢ @merE-
igs i) 53-60-1. igs |2 0104-cc3. ig
|2, igs |i)53-80-2. igs | 0104-cell. i
|] 4124~ Fansheqi-2. ig= | 2] 53-60. igs =] 134-1. igs
|6-a. igs i) 53-80-fix. igs | 134-2. 165
| 2] 6Led-Fansheqi-2. ig= |&]0104-2el. igs =] 134. igs
)22, i gs o] 0104-cc?. igs |2 0203, 1gs
Ld) | >
EEE W |1ies @ |
ILPMZERI (T): |IGES Files (k. igsi*. iges) | i

2) Insert>Part

[3

Select Part File to Insert
EHEE O | O HELK = cF BE-

IE\]l.igs @E—a.igs
ﬂmep u) B—a. oml
[2]2. igs | Bled-fansheqi=2. i
[ 3. bmp ) 6led-fansheqi—2. «
| 4led-fansheqi-2. ig= E\led-fansheqi—Z. 5

=3 6. BME [=14-21en
<l

THE®: | o |

IR (T ) i




W5, 16 PR, Tracepro A LUK AR P @ ar A, B HeEeHL, iy
. WA, @it Tracepro 1 7F 0SLO A%,

o =1ES

f| TracePro Expert

File Edit Yiew Insert Define Analysis Reports Jools Macro Findow Help
D[] &) &%) of | o[c|s] g x|v & DR(E(D|| w0l<]E o #e|w| 2w
®||8|&|8|&|&|5| #| o)t =] 2| d]w| D[a[E | P| Bl=]2D] 4|

). Model: [111. oml1]

EREEOQ: [ x| - @k B

1. 1en =117, 1en [F123.1en =133 1en
[=]111. Len] F 118 1en |F125.1en [H13¢ Len
(=112, 1en len =126, 1en

(=113, 1en len (=130, 1en

(=114, 2en len [F131.1en

=115, 1en .len [F132.1en

&

RIS ) |111 len
2R (D: [0S0 Files (k. len;#.osl)

For Help, press F1 X%:-0.0000 Y:1.0051 Z:6.8644 millimeters X:-0.0000 Y:2 7185 Z:-5.6217 millimeters /;

2. SRR
Tracepro HIEAR G, B AETRYEAT 8 M ) 0 B 24 PEAE Tracepro AOBEIEL &
T, ML H R AR S SR SR ORI . BT A SRR () 52 SO A AR R — AN

.
gnalysis Reports Tools

Auto Importance Sampling. .. WARH
Apply Properties. .. EXEH
Edit Property Data HREm R
Source Editor i HeE

#4%: Define>Apply Properties

1) Material HISRZE CSEAARIATEL

Wil #PRY BRT B3, AR PR T R AR &R 2t (iR E, XS
BRI, MERRIGE . TH, WA LLEd s FJ7 View Date S EAMEHIIX LE g .

2) Surface HRxE X R TH & 1%

AT AZE AL O () S TR AT 5 S e R B OB, WO, WU, B AR
R BRI E L — Lo, 555,



I Apply Properties

Importance Sampling ] Exit Surface ] Diffraction
Raytrace Flag ] Mueller Matrix ] Gradient Index
Fulk Scattering Temperature

Clazs and User Data ] RepTile ] Temperature Distribution

Material ]Surface ] Surface Source ] Prescription] Color

Catalog: v Hame: |EET -

Dizplay of index and abzorptance for given wavelength

Wawelength: |0. 5461 um
Index: |1.51872 Absorption |0. 0002001
-ansmission |0. 995001 througl (10 mm

l
l
l
l
l

o

M Apply Properties

Exit Surface I
Raytrace Flag ] Mueller Matrix ] Gradient Index
Bulle Scattering Temperature
Clazs and User Data ] RepTile I Temperature Distribution

Material Surface ]Surface Source I Prescription ] Color

=
Property |<None> ﬂ

Hot found in databas Eﬁég girg,ﬁr L

Ho Scatter Diffusze White

Flat white paint

Fluor White
Gahs

Importance Sampling ] Diffraction

Property |]Jefault

General Data l

=)
1

l
l
l
l

The wawelengths nsed during the Raytrace
are set uzing the Raytrace Optionz dialog ‘noner , no p G

. ]
Type: IR Gold L

Lens

MzFZ2 Single Layer AR
Mgl

Current Material on selected Object
BET from: SCHOTT
If <Hone* iz dizplayed: Check the TracePro

Database

hpply |

View Data View Data

Apply |

3. MRS HT
WK, —A LED JEIRESIE 1 KA R BERE BRI . 7E AR 5 BB A5 R Bk
HRPE, “PIOMRE, Bz inruigsi.

Irradiance/Illuminance Nap: [Untitledl. ONL] fEx
Total - llluminance Map for Absorbed Flux
Ohiject 2 Surface 1
I -790 -500  -230 ) 230 00 740 1

15 I
14

14 / \\“
1

i 7 i
12

12 / 0\
. I k)

" 10

10 /7 W

M / )

: / 4
[} E 7
7 E / \
- £ A

&

& 4

4

. 4 3

2 1

1 o

-780 -500  -280 0 250 500 750 Left/Bottom Right/Top
[t} ® (millimeters) — Horizontal —  Wertical
lluminance Min:2.85218-011 IUx, Max: 14 596 [ux, Ave:4.6821 X,
RMS:3.7259, Total FIux. 18 768 Im 71078 Incident Rays

4. GRS

TS E B

Ji R ZHH) B E Normal Vector EJ7 GRS 77 M, MAAFMEME, KiF<@
bR BB TR %7 . Up Vector Z% 75115 377 M H .



Ml Candela Options

Rectangular Iso—Candsla ] Candela Distributions I
Orientation and Rays l Folar Izo-Candela I
Hormal Vector Tp Vector Orientation
h X0 Marrmal

11 L
z: |0

111

T
z:

Ray Selection
The Normal wector

f* Uze missed rays for Candela defines the global
L direction of the
(" Use exiting rays from selected surface (hms Term omis Ear

(" Use incident rays from selected surface or E vertical angles.

The Up wactor

fats Frosesaing Dizsction of the
5 1. Zero axis for
smmatry [Hene ﬂ havizantal anclac

Set Defaults

Smooting WEICIRAHTIIXIAIRAA, BEEAIEH K, oHriX a8 H K
BRI, Ot NS RS E AR

r- Candela Options E|§|@‘

Orientation and Rays ] Polar TsoLandela I
Rectangular Iso—Candela Candela Distributions

Distribution Data Selection

EQEI pllol pedmis o hzrimuth angles are
[ edfldm Humber of horizontal 4 ;z:::z;::lt:ngles

. P for IES output and C
[ Set Max: [ Set Min: anele= for TOT

Folar Distribution

v Luminaire form  Angular width lar Luminaire

Luminaire plet width 180 or

Bectangular Distribution Rect Dist

[~ Log plo- fngular width a0 E:_;f ;

Apply Set Defaults

JeaRa M ARAEFRECE 2%
&, —A> LED G RO ALAREC G HI 2R 18 . AR R J7 SRR 45250 Rk, #5532
BRI H, RAOEE, BRIFPLIEE.



M Polar Candela Distribution Plot: [Untitledl.ONL] 9(=1E3]

Palar Candela Distribution Plot
Using incident rays on Object 2 Surface 1

170 180 9470

160 160

Efficiency:0.71047 - 71078 Rays
Iin:9.846e-007 cd, Max:15.373 cd, Total Flux18.8 Im

Jesma T EAAARARECL £k

[E/=)E)
Rectangular Candela Distribution Plot
Using Rays Incident on Object 2 Surface 1

80 75 €0 -45 -30 -15 0 15 a0 45 60 75 90
Degrees
Efficienc y:0.71047 - 71078 Rays
Min:3.8465e-007 cd, Max: 15373 cd, Total Flux: 18.8 Im
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Tracepro WitShl. M vt EK:

Y. Cree LED Q4 1101m;

TEREER: 1 KRR EARA T/ 1K, Hls BB AT/ 0. 12 K;

MRREEOR: 1 R ROR IR A F] 40001 ux;

O 3mm AN1L BT

AR 25%20mm;

JEPE . KOGIEE 1101m ,  PIESRMAIE 110 S

Meot:  BOCAARLNT 27 B, 6RMA/NT 6 2

MEREE HrlotaE’A 4000cd.

WL AT, AR Bt SR E ARG RO, BSOS I D4R S IR EE R AR R
T 1.

1. AP Insert>source

me pnalysis Eeports [ools fHa e

Dl|E & s[[a] <[] ofofe] o) ]| &l Oln/Eim] o)<l EE ol el 2|
@Jaa)a) I RIE]:] #] alt: sl w2l vl eln]| piIe| /] Bla) o] [

f). Model: [Untitled2]

I @ [{Lamp XE-E White Optical TracePro ASCix| 7 ©

XfHZER @ ProSource ray file (k. DAT:* RAY) = BiK

For Help, press FL X.0.0000 125, 5084 25,5430 miLLineters |§:0,0000 10,9293 Z: 0,574 nillimatars B |

File Edit ¥iew Inzert Define hnalysis Reports Tocls Macros Hindew Help

DB & 4[%[5] of =] olo|e| @l kv Z(| OlmBEIm] el D

Conpound Trough
Rectangular Concentrator |  Facetted Rim Ray
Comie | 30 Compound | Tromeh Colindsr)

Shape |Pym1n;| Ealculatlnsameler ]|

Thickness: [0 1 Length: [15
Hole |0 Diameter 21 908802
Facal length: |2
WA |

Rotati

1: o ¥ Jo
1: o 1o
z: |2 z o

in Degrees

Insert Wodi £

For Help, press F1 ¥:0.0000 T:5.5900 Z:24. 1734 millimeters ‘X 0.0000 T:-3.8431 I:-7 9370 millimeters /d




AU, R ELEL ApplyProperties RO INER T @M. i SHTX A

M4, SR A, &% ApplyProperties, fF ApplyProperties H1iE#¢ Surface. #
Surface [ FhRASHA 2 M O TS, AT DRYE B C0 7 EEF S &M S, ] b
Riidi View Date, HE X STHITIEME.

M Surface Property Editor

FEL & BEEA

8

i~ Catalog
{Add Tatslog

Delete Catalog

Catalog: | Defaul

LI Name:lﬂ? LI

Description; I

== Type: ITabIe ;I Scatter: INome O Hatro.rellactor
I~ Polarization |
Delete Property
Temperature (K1 Wavelength (um) Incident Angle (deg) Absorptance Specular Refl | Specular Trans
Copy Property
300 0.5 o 0.3 0T 0

~ Data Points
Sort by..

Add...
Delete...

Solve For.

|<None> hd
Flot Options

BTG, MOBHE AR E e, 7 BARYE EORAE SOEHM IR AT7 A0 3mm (160403

M Insert Lens Element

Lens IAperture I Dbstructionl Positionl hspheric I

Uni tz IRadius VI hickmess: |3

Material |

’;talng' |SCHDTT v | Wame: |131<7 4

Surface 1

[~ Cylindric

Surface 2
[~ Cylindric

Conic:

Radius: ID
ID

Conic:

Radius: |0
0

Modify Lens I

Inzert Lens |

3y ININ—ANE T

R INTE G, &5 T LI — 52 P 1 o $252 1 7] DARRARE SEPR s 2 e RIR
frE. BEEE, TATT N P ERRA RO, JaPRSUR S 45

B4, Insert Primitive Solide, ¥NINE5Z FMH .

HR, B2 P A Apply Properties H1 Surface 5& XN Perfect Absorbers

gos, md = Jrmmn,
4. BERGE , WARRRCE M2k



| M Polar Candela Distribution Plot:[12. oml]

Folar Candela Distributian Plat
Using incident rays on Object 5 Surface 1

160 ”50 - UEU” S BEE

oo Orientation and Bays | Polar Iso-Candela |

Rectangular Tze-Candela Candela Distributions
— 500
Distribution Data Selection
120 W Smeothing [300 plot points or e gles e
. converted to
110 110 [7 edfldn  Number of horizontal |4 horizontal angles
for IES output and C
™ Set Max ™ Set Mip:
100 100 = = anslas for TIT

a0 Folar Distribution
¥ Luninsire forn hAngular width o Luminaire
a0

“ =l Luminaire plot width |180 o
70 ‘ & 70

Rectangular Distribution

[™ Log plo hnguler width |30

Rect Dist

.= 0 Set Defaults
Efiiciency.0.61305 - 81936 Rays
Win:0.0071923 cd, Max:1438.7 col, Total Flux16.222 Im

MBI ZE R P AT DS, AT B0 61%, e KJtss 1438. Ted.
AEEBMAR , EMRAREOLHZ

Bl Rectangular Candela Distribution Plot:[12.oml]

EEX
Rectangular Candela Distribution Plot
Using Rays Incident on Object 5 Surface 1

— 440
— 8na

cd

Degrees
Efficiency:0.61305 - 81996 Rays
Min:0.0071923 cd, Max:1438.7 cd, Total Flux:16.222 Im

MAERL AR APl A, 2 Jesm N 6 2.
EAEBMAR , CHNE

M Irradiance/I1lominance NMap: [12. oml]

Total - lluminance Map for Absarbed Flux
Object & Surface 1

5‘1lguzxzﬁ__ 400 -300 -200 4100 O 100 200 300 400
1000 . e
316.226——| A ! . @ 3
100—
31 5226——
10|
3.16226——

3162 28

1t
0.316228—

01
0.0316228
0.01
0.00316228
0.0o1
0.000316228
0.0001
3.16228e-005
1e-005

000316228
h 0.001
0000316228

v (millmeters)

3.16228e-006 e ‘
1008 -400 -300 -200 100 O 100 200 300 400 Lef/Bottom Right/Top
® (millimeters) — Horizontal —  vertical
3.16228e-007

luminance hin: 1.59732-008 Iux, Max 1076.1 Iux, Ave:16.213 lux,
RMS5:62 764, Tatal Flwe 16 213 Im 81396 Incident Rays

ML A R PRI PR 1 ORADEPE R EARIE KT 10K, AL KIR Y 10761x,




SRR EE 16. 21x.

5. e R
ORGSR, SeTRIGE R 26. 41m. 4ETEIIYGE RN 1201m B, EIEERMAA
AR BRI SEAAS, dutssil 6086. 8cd, 1 KAbiR KGN 45521x, X ELeit B

Ko HERIHRE, Bt

CUHERGED

Tracepro /& —E 0] LM R G0 AL GRS A, Fa 5 BE UL SOGEE 73 A i B
EHEHE —EHRE TIARMER ACIS LRI 2 A KR R BCHLERAE . DhRE R K
Tracepro J%% 1T G IE N A BI57 858 EE, 54 7 RERA IR, 4% 7k, d&n]
DU H B 22 o & B s RO 5 7 i o

KITHAH T Tracepro BAF I EEAERAE, HBMT B DER: BB, Sk, 6
WBOE AT DR . B HARO S B R R R E LR B AN ] N4 T 1s H
Tracepro MR — N REIEARRERAETFIEE 7.

[BE5531

v Tracepro YA BRI ARSI B0 BR AN 2 AT DA G VEHALA -

v AR R A A R AR R A TR T i ?

+ fE Tracepro Y& A B THEAFREAT BAUL 0I5 FLI Qo] B8 7 B A 3R 2 7 2

« ARIHE A T RO EBI B AL, IRYEFTARIR, E1E Tracepro F12¢—i&
Gl AT B AL ?

2 W N R

—

EES



WHLE  REDEAE R

[TiHE£E]
R et AT e et KT e MRS K AR A BT TR, RSO SR

AMEIA TR YRR BT, Hop s N R BT RAMNE AT R, (R R BT
BEIE 2 B AL AR ACR . SRE N R —, ENIRIPE DA SCERE N TR
F & IR T BB G B g B 75 =0, AT SO RN (K RO R IR R T 3R 2 o TR
BT KA LED S8R, Hir= i, 756 B T BRI BUE .
[50iR E#R)

1. T fRRE B2 B AR I A B a3 s

2. HEIRIROA BT R AT BT B IA G S Jeisde. JetEst. JulE. R,

i, BOrkss,

3. HERMA VD RJE N 224 PR R A BRI R ShEgtE s . e IR .
[HEeEHr]

1. %§% DIALux B SEA A E R g

2. FIH DIALux #A4EF1 DIALUX KT KSR 56 i R = A B B B 155
[ ]

FIF DIALux A4 A1 DIALux AT 5eHE R 5E R SN BA ¥

[EFIAEHH 7]

MR BT AT e BETt, IR BeiH 4537 50 O S AR vt A = py B it
Horps A IR E G AR A TT R, (2 e 32 B Th eIk o 2 S {4 2 ) JE ] 2
Ro BE, SRR IES: A2, =248 SR 78 731 W S S R RS
TSI RIS R ETE USRS . &, AT % A TR THBOR B EE AL .
AT H @A DIALux BRAFEAT B A A I e, e EN S RERE . EAXES
Piih BN, EABIOSMRRE, ST REFSKE, HOtsice, I, JF
S SEE R


https://baike.baidu.com/item/%E5%AE%A4%E5%A4%96%E7%85%A7%E6%98%8E/527775
https://baike.baidu.com/item/%E5%AE%A4%E5%A4%96%E7%85%A7%E6%98%8E/527775
https://baike.baidu.com/item/%E5%AE%A4%E5%A4%96%E7%85%A7%E6%98%8E/527775

f£%— DIALux B/ RITHERER

—. DIALux fajf+
DIALux +&{&[E DIAL Gmbh 2 7] K& 1 —FEE X Tl BBA vE T 8 pE . mlfiRl, 15
AIRRAL B P 5 EE A X R, ABERRER S 5523 () 2 A0 15 25 7 B it IR 1
HERTHAET R RIBHEIT R . DIALux B T 44513 R B IR ATHE R4, Ehe
W2 H AT FTA BT R R
1. DIALux 8 = BURE i1
(1) FIEREE KT B AT RS T 5
(2) J#IT DIALux fr8 E AN RE PR A IE A e vl 5 B IO B 45 440, ORI v A

(3) Jfdi. PR S BT RR R T R R, R e B R R

(B FB. @, T B A= BER. S @5y, BB TR HENE
(5) AIEERs . FERLERAFIT H, 25 B R A LT B Puid 2805 A
(6) AL 3D ], TR HEHRE R =R,

2. DIALux B J7 Mk

B 7RG http://www.DIAL.DE Y, http://www.DIALux.com

3. DIALux UL 2EH1F

DIALux ZE W LBEFEIR) ZK A : OSRAM. PHILIPS. MEGAMAN %;
AUGEBE T )R ZHEHOE. TCL. NVC. SFTLIGHTING. BHYGHRIAZE:,

=T R
DIALux A& R 2 H T HRisi 45 51 FH P 34T DIALux ik B3 A
1. DIALux 4T YeHE R Blbs S 4T 75 =X

T

DIALux £ &

W BRI
/ DIALux KT¥cHs

M

Ca e

DIALuwe 4. 4| |DEALwe 4.4
Li ght



http://www.dial.de或http/www.DIALux.com

2. KDEKERIT R, B L il — YO m i, AT SRR
HREER AN DA G, RN DR,

3. ERIFRMBURIE L, GBS 7 8 . XL HE S H S BT BN
ELE L

5 DIALux AR EER
| FWEEA] DIALuk AT R, SRR T

HARRAGHIERT | FAETT DAL it

HATTRSR:
* EHEREEA.
* AR, ST R,
+ TR, TSRS,
* FIEMATETRAHERANE. FHE FIF T I RitE.

— DIALux STERR - [B]%]

mitEnH n

SATHE, D, TSR, %

[
@ik L
BEEE: DETEHA WEA: R R AR
FER: ThEE i OTED- 3238580
whitRRHEE : OO Z3L 3456
w1
e Emil Lightingzed 125 com
B e B4 L
28 BRI
AN - 45 D e
= b S M AR

26 RE: B Bt E SRR R R,
L DEERHHTE [KHEE
2

ERET

2
. OoepLenunn
: )

T SRR !
BHEFE.

Ei—goF—Fw > [_®n_]

& DTALux $TSERER

HEBA o
WA AR T AT @
]

A Rt TRixH

KR o 2000 |, @M i : iTH: « (& B®

TE k) [12000 0y EREE: -

W 2000 | |:| MiEmEER. GMEFE

b B 5 0 A0 4 4
C#m L kg6 I:l o
e L3 3
d: L]

EMES

EaMi: [0 v s BEFEEY | T

e S0 v % SR v E=l . F -

g [0 vis e ¥ mETASET s
TiASS I#E BRAY IHE

SR : B om0 |a T TR -

R = EEEM: (000 n f= 0 -

mrEm: o

) e )

4, (EHWERINE O, AT LR e A e A B LT AR . —fBokiE,  DIALux



ISS R U e e N AT
5. BRI H ok, RETTR — ) R BB AT R, & TR A B
SRJE R AFEF . DIALux SXIN ORI 1T K Son e EA .

& DIALux #T3ERA

BHBA n
ARSI AREE A, ﬁ
{

SRt IT Rix™
R w: TEE . TR QPTLE 140002560 WNP1LSI-T -

i Bl
RE Gj: (12000 |a IR OFFLE
st |

b
I8 L miesa _ - Fil: WZIERAZE - ) 1 o

- " WA = { ] LA
d& oy LT L) :“u‘&‘\’
HiRR 6691 U/
EHER —
EEM: 0 v s BAFEER ~ CREEHE
e 0w IR - SR WA ~
MR: 0 )5 [Ses vl TSR BT :
S Ife® Bl : - THE
AR L. 8 om0 s ST ENER :
R o— 5 —
w7 v e e AET—FHANT— —
AR
meEm: 0@ Rt (6 x®e @) |
E=D) =1 |

8 DIALux SRR

HRRE A
T ERITOSRRSTEN 1OF L. m
ERiEH TR
[IRE R FITREEE Emr o MesaERl (BLRF) v
| o =
- = = o 2 F—ERSENE (R v
~ “‘g iaany TRSS
— — Oy (O]
EECT] FTARES g " Omr
UTE
;—vr- ﬁ‘——l
e WEHE
EITPMERBRPERES 7] k. @RSt
WMt HER [ A LeTHeR B RER Lo
o) M ‘ [ Ao mwmn e ex 3 SesRIAN
&5 160 [H B MaLs BIHE
% FESef—Fw 3 L]




o DIALux $TEMR

HEEN

Tt SRATIIERMRTY POr 4,

BEREE TTASEHE
FlEitEsE Flrasne Enmr [+ e EEE) k3
- B ﬁ_ | 2 [ R—EANAAE 0m) ~
- ’*E i T
- Oy ®ce
EzAes FITAERD Onr Omu
== — Own
ma=i jﬂm L ;3.0
[FJvon A RBERE
DR SLTRenRRER
ol BR A swen e |_:,§ e BB
Bt WA RITENR R
& o el wrmewx |6 mRERHE

mm%m

bl Lo
HEEL
EhviE W
{;:}E_\j = [*mg}., ._f;ﬁl_,l, e
e T i) Tl
Gﬁ? $nw1 3n?w o) S5l e
Ed Taea' | MOPETE
TR T T Tl -
=G ) (0] =(E0)) Tl e
T TR 0K
: I I =)l [
50 18k 125 T
2 o 2B S [
L s na T 20:102
SNER 200 KRR 2000 n LR o0 LLLRTE R
n | #ma A L] AR Bans &N /FANR
v ‘ = = = = o
e k] - - - om
L 2.1 - o7 = ]
R
& o m
ne DA
an a0 -
Lt S
Ll R Em WEEE) g ™
1 34 OPPLE 000 MO 1984 { 10000 L1} 1240
e woa  mm0

SRR A W s G WA (I S0 )

EEFHECTEERSES
MRERES. mEEL. KA
TR ERMESEE




5= ZATRER

— HEFEXR
B E N A E] S CAD SR E AL — NI FE A

= EFLH

(—) FLIPAEZH

1. A CAD Xff (CAD 3a_Schriever) ;

2. VIE 1 72 B A RRE, IEE NETRAL (BENEED B AEAE, T
= CAD WAL 2K

3. WINEEEE: 2.8 K;

4, JRETEE. YEP R B HAMBUE L BROME

5. @5 REEARRNE, JFHUTESER M E WA, R £ CAD
HH T RS A TR R

6. HSLI], VR £ CAD HE T BFR, 1718 2 K;

7+ RAESCHE N “AESS 3audIx” .




~ WO N -

K2

]

=T

% 3

() M= N 25 (R LA

« AEAT T IX g — BRI M T, RIS L 0.2 2K

V FEFEE DN RAERE L, B B IEEHE, S 0.2 K

v HNEE T 2.8 K

.« W 4, CAD Pt iE (B T b A B —HRAE

- WNE S, VRGN A a0 (R SLOT RS A, KPR



6. BT 5 MoK, fLT 80 HOKA! 200 KIS,
7+ DRAF LA

K5



%= ZAXEEMH

—. FEFEXK
FEAFXESW: AENERTHNEE S

. EFLH

(—) FEENT R INR A

1. $THHAESS 3a TP A ZE SO, BT H“4a_% N KB 590 /DX XA R H )
{4a_0.dIx);

2. N 6 s, fEEEINEEINS N FE

3. I E B RST, R AE BELERTiEE, A4,

4, UNIMETAE . BN, BRI R R, Y 3 sl E AR
fl'5

5. PRAESHFN“4ESS dadiXs

6



K 7
EZENZER AN E B ERIER LRI —A T

1. JTREKE: 515204055 5 56 FEAHTE] (4.35m),

2. MTHERSF: 9% 0.2m, & 0.2m, BIEPYHE 0.1m, HUE 0.04m;

3. BEAETE

J7iE 1 AEH SR A FTHRARAR”, LR 454K .

J7i% 2 AFH“BRUELSE ST IR, R RBRThRE, Ul S ) R 7 o .

7k 3 ffHFRUELEAE B IEAR”, BRI . XS, HieE R

4, W7k 2 WM. AR —Ifikd CRIA shift) MRS 3R ThRe, BHEEIEN—A
X HE;

5. FEIEIR AR R v E, DMEHEMH CRUCK R S BE T R0 );

6. [FH“FHASREXNE”, KRN sat #5205

4 8



2 JF-0.04m

0.2m
0.1m | |
i

0.2m

K9

&% A% TE EBES | itEEnm

HE R =

x:[0000 |n ¥:[0000 |n Z:[0.000 |n
HMERE SR EA LEA B RE U EAIEH L
T, EEEEHENRAERF.

K 10

EFN BeS5HR

—. EZER
FENEIE SR
= 5L

(—) ZFEWN 5. KRR TR

1. FTHAES da HIIMAZE SO, BT “5a_% W 5145 /Dx” SCHE I HR )
{5a_0.dIx);
BRI N SRS KA TR
v WM R B T ER TR, e AR AN, 1 Shift g
o SRR T R o B R AR R T
- ARRII T REARR I, V. MRS ERE RO, v DUH SHIFT S8 Ab B BN 3R 1
SHTINE EMBE, R SCREIF I, n] DR I M BSOSO iR 1 A s

a b~ W N
7



7~ PRAFSCAE 4RSS Sa.dix”s

(=) W5 EE 6w

1. H. Y-S AN, £ (5a_= NI 58 5 \Pictures Participant) (/4 J¢4k
B % FIM B “window_fixed.jpg” A1 “window_to_open.jpg”

F&T BN w3 s

2. ABMBEK RS 575m, SER/NEE .

Kl 12

(=D i EAR I
1. HSEIT AR, S E—Smb, RS EE;
2. R AR RS e A A B



3.
) ¥l 1

N o oo b
v

Ry =S A, 7R (Sa_%E N ZI 58 5 \Pictures Participant) {4964k

o TN G Bk CyERAE A SHIFT 821

K 13

BB RS 5051, 5 EAR RN R

[FIRE, WTCAAEIR A SRR BE b, MR BRI OERERE . R

~ HCRBRT ThEg, Ai/RISEEIE QI PR A, RSEEE;
- HEBM B RS 5071, /TR EESO JT A

K 14



EFH TRERSHE

— HEFEXR
AT HRIERSIE

. EFLH

() EE N kAT A

v FTIHESS 5a IR A=A, BT DX XA (6a_0.dIx);

v W NEPR, s AT E A R A

“HL T BT B INA R BERIT R, R ICRAR O )
LT BT E EBON AT, AT RS B R>4% Co-Go HEF, e BT A

A WN -
J s

=y

5. “EZHA AR E WL ST LT, FE e A b BT B RS T
] 5

6. “HR—AT H YR R AT BN KA ST, AR BT RS A LE: A
S A AR KT B T A Rl B B kT B A i 1]

7 PRAF SN 4TSS 6a.dix”s

K 15

(=) 23 KRB A R HES

1. % FEFR, b AT AR T H

2, “BESAS A ARG RS OEE: EmEH BT ARE]

3. “ELEHRS A BN AR IPERS T, R e A R b v B R AT B AR T 1A

4y DI AG B AR PR A BT R, AR R S R i BT B e 7
A, PUSRCERANMT MR T5 17, D FEOUAL IR iR 2 47 B2 R e e 2 15 110

5. “BEHS A E DGR RPA BIEHSIAT ER: B, ERERixRE]



6 TRAFICIF

r%ﬂ]j | EESI SN || S A=

I ] 4

MV_J]iJ]]ﬁ 7.H?H«|n|

i
il
i
|

K 17

] 18



EFN TG R

— HEFEXR
EAITLI R
= ARSI
() RN T E PIEFAT L
1. 379F 6a AP oe k] BAT B A B CHF, BETHF DX X (8a_0.diIx);
2. BAITHATB AR (EE: —MTAZRER A EHEEE. ]
PEHIRE 1. &
PEHIRE 2: B
PEARE 3. 542
PEHITE 4: BEAE
FEHITE 50 AHY)
R 6: AR
R 7. SUOR

3. QIE=AMTe s TR, 2 KN S St sl R BRE 1 .

TG SR PRR %
& 100% W 100% Gl 80%
FIR 0 FIR 80% FIAR 0
Hze 100% e 50% e 80%
BEFH 50% BEAE 50% BEAR 80%
=k 80% =K 0 =K 40%
IR 80% IIA R 10% IIA R 0
e 30% LU 50% PR 0
i, BFE&% 4. 15, BERG R,
5. TRAFICAE.

(=) PrBbEET e 5



1. FIHF“Dx" LI ] (8a_z1_0.dIx);

2. BT BRI EHIRE: R

FERIAE 1
FEAlAE 2
FEfilHE 3:
FEfilHE 4
FEfilHE 5
FEfilHE 6:
FEfilHE 7
Pl A 8:

L BT
FEHE IR
Hh e W A kT
BT
PHE ST
FRARAT
W BT
B8 ST

NI AN EEIE AN R

WE=AMDE S T 2B RN B Sh it B E i T

REGR PHRG R XRIW 7

JEE AT 10% T AT 80% T AT 80%
HERAT 10% HEmeT 80% HEmrT 80%
rh ] AT 10% ] T 80% Hh ] AT 0
BT 100% BT 0 BT 100%
PrEaHT 0 PrE ST 80% PrE ST 60%
AT 0 AT 100% ST 0
P RS T 0 P LG AT 0 P P SAT 60%
S ST 50% HNEISETLT 0 HREISHKT 60%

4, W, BESIHREA
5. RAFICAE




5t SIANHBRTESE R

— EFEX
SN RIS, fTEN

= EE Lk

(—) TE=E N A R AT

1. 19 8a HHIMES E e (8a_z1_0.dIx);

2. HUUT B OIS AR

FEHIRE 1. SEAHE —HIMAT

R 2. SEAE—HIHAT

PEHIHE 3: A RS

FEhRE 4. GBVAT

PEHIEE 5 YFE BT

PR 6: SBARAT

FERE 7. AEISHT

PEHIEE 8: ANBISHT

3. BT e E: ARYRE; [ER: ‘AR IEE: A mkEE, kb
“HARELEER"]

ITHeS - AEXEF | EiE

[+ E S EE: B ()

[ i+ 8 B#AYEEEEE (B)

HEA @) - 2012- 3—21v|H?II‘ETI: |t0:zB:00 & |

R0 AR v|
HEEAFRXCH ()

K 21

- BB JBE, R

P AR D B E B AT R, IRBRYIRCR I FIN, SR 6
VL ARSI RACRE IR

 DRAESCAE

N o b~




(=) s
1. FTIFDX AR €9_0.dIx)s ;
2. gkt es—REH, AFEIL. (AR
05 FRA N w1V = B RS Ml = P05 = ) |
THES - ABXEF | EuE |

[Vt EEIE B 1)
iHH B2 (B)

2012- 3-21 « |BHE = | 10:28:00 £

FEER W A
EHERFRAER 3)
K] 23
3. WEMIA. b I TE S
4, I8, BESHFEBR,
5. fRAF3CAFS

K 24



(3 H /M
AITHA A T = N I B (0028 K w5 A5, [RIEal A A DIALux 3
BEATENE RIS, BT BN AR, EAFESMEEN, ST SR
WH, FNTHREFSHE, IO RcE, 5IANHG, JFfhitEasiR.

BEEZHIN
{7 SR L8 22 1] I A PR ST i s
fa R T REVE N TR BETH I 2RSS .
T3 & A BT BT AR -
g3 = A R BT R T L 5 A KA
i & A BT Bt AR K
T3 S B P N IR0 (1 B S5
FERIFERDEIRSEAT T, TR B i AR X R 858 78 B B RN B TR 3R
AT T L 6 e 1) SR EAT 5 2K
{7 38 72 S TR P A 1 e T 3
10 IR T H SR R HRr s AE v
11, Wik BT E .

O 00 N O U1 » W N B
J J s J s J s M M



THEE &R

(&R E#r]
1. T fRE AN E 4 SRR B P
2. 42 LED TAE BT L REG;
[H:eEEH7]
1. AEEEHRUSCERE B N A5 42 il R R I 7
2. SRR R LED TAER T .

[E%IAETHE 7]

NEMREAZTSFTEXROCHI R, IR R o JRAE NSRBI, AN
5T, B2, BHECRERRE, ARPDEHIFWRREMNZEL R, BRCE, TE2Y
kR, ELFEEROCRRR, WHRNTERIME SRS AR, HTENLM R R
AT 2, BmAE, sk, R E RIS A .

B 8-1 RO AT M i i FLOS FROXT Bz it

H%— BEHAMNER B

E br EA V2 KT E e R AT H i R, I s KR R A
flos. artemide. foscarini 5[ PFRZE144 4T H i FE

Artemide

WEFR AT R 2 RFT B Artemide 0L T 1960 45, &4BRE KIFIT
BAP Mz —. Artemide MU H 2 SIH B 32 SCHRE S0, Q0FE NIRRT
DR RN RS, S8 BB 2Aa i O E, T st W R



MSTANMAE HEE R T H . Artemide $ H QLB i S B ST R 004 4
“NFEZO6” (HUMAN LIGHT), &A®ELKOL, ErENMIKHEEER S A
ATFIEYYIE, XM Artemide BB OIS

FEIE 60 “EMRTAJ L, Artemide A= BT H 22, AAERMEMMHE: Tizio
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Castiglioni JLAAR4IIHING/ERISL T FLOS.
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VAR TAEFIRAIT 79 2 W B A, KT R b 0 S = e i AT I3 28,
FEXRTAH SRR BEAT Gt 00T s EFAE 4 4R 11 A I BRI AT 1
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